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Installing the Software 
1. Insert the installation CD. The installation will start automatically. If it does not, browse to 

the setup.exe file on the CD and run it. 

2. Follow the prompts to finish the installation. 

3. Connect the instrument to the computer with the supplied USB cable. The drivers for the 
USB and Virtual Com Port will be installed. 

4. If the Welcome to the Found New Hardware Wizard appears, select No, not this time. 
Press Next. 

 

 

 

 

 

 

 

 

 

 

 

 



5. When the Found New Hardware wizard appears, select Install the software automatically. 

 

  
 

 

6. When the Windows Logo Warning appears, select Continue Anyway 

 

 



 

The driver install process will now be repeated for the serial port drivers. 

If during the driver installation Windows asks for the location of a file, browse to the CD drive and 
select OK. All the required files are on the install CD. 

System Overview  
 
Welcome to the SXI-D Digital Instrument Application Software. This software, when coupled with 
a Spectrum Detector SXI-D Instrument, provides the user with a versatile measurement system. 
There are multiple sensors available for the system. When a sensor is mated to the USB module, 
the module reads the sensor type, sensor calibration, sensor wavelength response, and 
configures the hardware appropriately. When the Application software is started it queries the 
SXI-D and configures itself for the appropriate measurement system. For this reason the 
application software will not always show all control and indicators, i.e., it will not have Trigger 
controls and indicators for an Optical Power Meter.  
 
The Applications Software communicates with the host PC via a USB port. The system uses the 
SXI-D Command Set to do this. 
 
For Joule Meters and Radiometers, data is sent to the host PC when the instrument has had its 
data gate turned on, and triggers are present. For Radiometers, data is sent at the chop rate of 
the external chopper wheel, but data should be limited to between 9Hz to 11Hz. For Joule 
Meters, data is sent at the pulse rate. The pulse rate is limited to between 1Hz and 1 KHz. 
 
For Optical Power Meters, data is sent when the data gate is turned on. 
 
 
 

Communications with Host PC  
 
The SXI-D communicates with the host PC via a USB port. The device supports full speed USB 
2.0. The implementation of the port in the host PC is accomplished via a Virtual Com Port, or 
VCP. This in effect mimics a standard com port so that the user can take advantage of the ease 
of developing custom applications with existing terminal emulators.  
 
The Ports Settings are: 
 
Baud Rate : 921600 
Data Bits : 8 
Stop Bits : 1 
Parity      : None 
Flow Control : None 
 
The host PC must have a terminal emulator as well as the SXI-D USB drivers installed. 
These drivers are installed by the disc supplied with the SXI-D instrument. The files are:  
 
1. UmpComXP.inf 
2. UmpUsbXP.inf 
3. UmpUsbXP.sys 



4. umpf3410.i51 

 
When the instrument is plugged in to the USB, it will wait for the host PC to send a 
carriage return. The instrument firmware uses the received carriage return to determine 
the baud rate of the host PC. This is done to enable PC’s that do not support the 921600 
baud rate. When using the applications software, this is handled automatically. If you use 
the instrument with a terminal emulator, simple press enter after the connection is made, 
and the instrument will return the discovered baud rate. At that point the instrument is 
ready to use with the terminal emulator. 
 
 

Data Format  
 
Measurement Data is sent from the SXI-D as an Hexadecimal string. 
 
For a Radiometer or Joule meter, pulse amplitude and period information are sent.  
 
The format is:  DDDD,DDDDDDDDCRLF 
 
Where DDDD is a 12 bit value representing the pulse amplitude and DDDDDDDD is a 32 bit 
value representing the pulse period counter. The values are comma separated for easy parsing, 
and terminated by a carriage return followed by a line feed. 
 
A full scale reading in any range is 3276 counts. To find the value of the pulse, divide it by 3276 
and multiply the result by the range. 
 
One million period counts represent 1 second. To obtain the pulse frequency, divide one million 
by the pulse period counts. 
 
For an Optical Power meter, the counts from the internal ADC are sent.  
 
The format is: DDDDCRLF 
 
Where DDDD is a 12 bit value representing the ADC counts and terminated by a carriage return 
followed by a line feed. 
 
A full scale reading in any range is 3276 counts. To find the value of the measured power, divide 
the pulse count by 3276 and multiply the result by the range. 
 
 
 
 

Command Set  
 
All host commands and queries must consist of 3 alphabetic characters followed by an 
optional argument list. If there is more than one argument, they must be comma 
separated. All commands are terminated by a carriage return followed by a line feed. The 



format is: 
 
abc<arg1,arg2,…,argN>CR LF 
 
The 3 characters are case independent. If the command has arguments and the argument 
is valid, "OK\r\n" is returned unless noted below. If an error occurs, "ERR\r\n" is 
returned. If the command has no arguments, it is interpreted as a query if applicable and 
the value of the current state of the parameter the command is returned. All returned 
parameters are terminated with a carriage return followed by a line feed.  

The following list of commands is not complete. There are commands used for factory 
diagnostics and calibration that should not be used by the user. 
 

Command and Query List 
 
VER. Query only. Returns the factory firmware version. 
 
VER\r\n   Returns "n.nn\r\n" where n.nn is the firmware version. 
 
STR. Command only. Enables the trigger engine for triggered devices, and starts/stops 
the data flow for non-triggered devices.. The argument is a Boolean flag. 
 
STR1r\n   enables the trigger engine or data flow. Nothing is returned. 
STR0\r\n disables the trigger engine or data flow. "OK\r\n" is returned. 
 
TRG. Command and Query. Sets the trigger level for triggered devices. This command is 
not used on non triggered devices. The argument is an integer from 2% to 20%. 
 
TRG<arg>\r\n   Sets the trigger level in % of full scale. Nothing is returned 
TRG\r\n returns the trigger level in % of full scale, "dd\r\n". 
 
RNG Command and Query. Sets the measurement range. The argument is the range 
value. Since ranges are not fixed for some devices, if the range is not allowed the 
command will return an error. 
 
RNG<arg>\r\n   Sets the range. Returns "OK\r\n" if successful, "ERR\r\n" otherwise. 
RNG\r\n returns the current range, "nnE±N\r\n". 

 
MAX  Command only. Reads the Sensor Maximum Range.  
MAX\r\n   Reads the Sensor Maximum Range.  
 
MIN  Command only. Reads the Sensor Minimum Range.  
MIN\r\n   Reads the Sensor Minimum Range.  
 
ZRO Command only. Sets the baseline of the internal signal at the ADC when using an 



Optical Power Meter. Uses no argument. The baseline voltage is 400mV. 
 
ZRO\r\n   Sets the offset DAC so that the ADC baseline is correct. Returns the value the 
offset DAC was set to and the ADC counts, "dddd,dddd\r\n". 
 
USN. Command and Query. Sets/Returns the user serial number. The argument is a 
string. 
USN<arg>\r\n   sets the serial number to <arg> 
USN\r\n returns the factor serial number, "abcd\r\n". 
 
UCD. Command and Query. Sets/Returns the user calibration date. The argument is a 
data in mm/dd/yyyy format.  
 
UCD<arg>\r\n   sets the calibration date to <arg> 
UCD\r\n returns the calibration date, "mm/dd/yyyy\r\n". 
 
SQL Command only. Sets the internal attenuator to full attenuation or to the current 
attenuation value. Used to simulated blocking the external beam so dual channel 
applications can synchronize on the same pulse. Argument is a Boolean flag. 
 
SQL1\r\n returns nothing, full attenuation, signal is blocked from trigger engine. 
SQL0\r\n returns nothing, current value attenuation, signal is applied to trigger engine. 
 
 
HLP Query only. Returns the list of commands. Note that all commands will be returned, 
including the factory commands for calibration and diagnostics. Use of any commands 
other than the ones listed above can invalidate the calibration. 
 
 

The Main Display Panel  
 
The Main Display Panel has five display regions. They are: 
 
 
1. The Digital Display which is always visible. 
2. The Strip Chart, which is on a user selectable tab. 
3. The Histogram, which is on a user selectable tab. 
4. The Tuning Needles, which are on a user selectable tab. 
5. The Setup Controls, which are on a user selectable tab. 
 
 
 

The Digital Display  
 
The Digital Display is always visible to the user. It contains Controls and Indicators. A control is 
an input to the application set by the user. An indicator is an output from the application for use by 
the user. 



 

 
 
 

Digital Controls  
 
The Controls on the Digital Display area are: 
 
Data Collection 
Log to File 
Display as % 
Range 
Trigger (%) 
Null 
Batch Size 
Auto Reset 
Sample Collection 
Collection Mode 
Time Interval 
 
 
 

Data Collection  
 
Data Collection Control. When active the data is collected for display if the device is triggered. 
Data Collection is suspended if another control is activated, then resumed when the other control 
is released. This is done to prevent the communications buffers from overflowing. 
 
Do Not disconnect the device when Data Collection is active.  
 
 
 



Log to File  
 
Log data to selected file. if no file is currently open, a prompt will request the file to log data to. 
Data files can be opened, saved, closed and viewed via the File menu.  
 
 

Display as %  
 
Displays the Std. Dev. as a percentage of the Mean.  
 
 

Range  
 
Selects the desired device measurement range. Note that not all ranges are available for all 
devices. The Range Control has its ranges populated at program startup depending on the 
sensor type and responsivity. 
 
The following limitations apply: 
 
Joule Meters and Optical Power Meters.  
 
The Top Range may over range before the full value of the range is met. This is because the 
sensor may saturate at a lower value than full scale for the Top Range, but partial ranges are not 
available. That is, a sensor may saturate at 156uW. This will require that a 200uW range be 
available, but only 156uW can be measured before an over range will occur. 
 
 
 

Trigger (%)  
 
Trigger control. Selects the desired device trigger level in percent of the Current Range. Control 
Applies to Radiometer and Joule Meter devices only.  
 
 

Null  
 
Subtracts the value of displayed Power/Energy or Irradiance/Fluence when pressed from the 
subsequent measured values. Releasing the control returns to normal measurements. 
 
Note that the total maximum displayed measurement, that is the measured value plus the Nulled 
value, cannot exceed  the selected Range when Null is active.  
 
 

Batch Size  
 
The Batch Size to collect in Fixed Sample Collection Mode. Resets with the Reset Button or Auto 
Reset.  



 
The number of data to plot on the Strip Chart when using a Joule Meter. 
 
If the Current Sample exceeds the Batch Size when Fixed Sample Collection is selected, a Reset 
must be issued to start the new batch.  
 
 

Reset  
 
The Reset button resets the current data set in all collection modes.  
 
 

Auto Reset  
 
Resets the batch when the Current Sample meets the Batch Size if in Fixed Sample Collection 
mode.  
 
 

Sample Collection  
 
Sample Collection is: 
 
Continuous. Data is streamed whenever Data Collection is on and triggers are present 
(Radiometer and Joule Meter). 
 
Fixed. Data is collected whenever Data Collection is on and triggers are present until the Current 
Sample meets the Batch Size.  
 
 

Collection Mode  
 
Collection Mode is: 
 
Streaming. Data is streamed at the data frequency rate. 
 
Time Interval. Data is collected when the selected time interval is met. The Time Interval control 
is shown when Collection Mode is set to Time Interval.  
 
 
 

 

Time Interval (s)  
 
The Time Interval to wait between taking a data point. Intervening data points are discarded.  
 



 

Digital Indicators  
 
The Indicators on the Digital Display area are: 
 
Live Data 
Min 
Max 
Mean 
STD. DEV. 
Data File 
Rv 
Wavelength (nm) 
Frequency (Hz) 
Max. Freq. (Hz) 
Max. Freq. Exceeded 
Triggered 
Corrections Active  
 
 

Live Data  
 
The Main Display for: 
 
Power (W) or Irradiance (W/cm^2) if the device is a Radiometer or Power Meter. 
 
Energy (J) or Fluence (J/cm^2) if the device is a Joule Meter.  
 
 

Min  
 
The minimum value of the current data set. Resets with the Reset button or an auto reset when in 
Fixed Sample Collection mode. Updates on each sample.  
 
 

Max 
 
The maximum value of the current data set. Resets with the Reset button or an auto reset when 
in Fixed Sample Collection mode. Updates on each sample.  
 
 
 

Mean  
 
The Mean of the current data set. Active in Fixed Sample Collection mode. Updates when the 
Batch Size is met.  Resets with the Reset button or an Auto Reset when the Batch Size is met.  
 



 

STD. DEV. 
 
The Standard Deviation of the current data set. Active in Fixed Sample Collection mode. Updates 
when the Batch Size is met.  Resets with the Reset button or an Auto Reset when the Batch Size 
is met.  
 
 

Data File  
 
The path of the currently open data file. If the indicator is empty, no file is currently open to log 
data.  
 
 

Rv 
 
Responsivity in V/W or V/J for the selected Range.  
 
 

Wavelength (nm)  
 
The wavelength of the light source being measured. Enter this value on the Setup Tab.  
 
 

Frequency (Hz)  
 
The frequency of the measured data in Hz. Resolution is 0.1Hz for 1Hz to 10Hz, and 1Hz for 
10Hz to 1000Hz. (Radiometer and Joule Meter Only)  
 
 

Frequency Range  
 
The allowed range of chopper (Radiometers) or pulse (Joule Meters) frequencies.   
 
 

Frequency out of Range  
 
Illuminates when the Frequency is outside of the calibrated range. (Radiometer and Joule Meter 
Only)  
 
 

Triggered  
 
Illuminates when the device is Triggered and Data Collection is active. (Radiometer and Joule 
Meter Only)  



 
 

Corrections Active  
 
Illuminates when Wavelength Corrections or Transmissivity Corrections or Area Corrections are 
active.  
 
 

The Strip Chart Display  
 
The Strip Chart Display is visible to the user when its tab is selected. It contains Controls and 
Indicators for the Strip Chart. The Strip Chart functions differently for different applications. This is 
due to the large data sets and date rates possible when a Joule Meter instrument is used. 
 
 

 
 
 

Strip Chart Controls  
 
The Controls on the Strip Chart area are: 
 
Auto Scale 
 
There are more Strip Chart Display controls available in the Display Options Menu  
 
 

Auto Scale  
 
Auto Scales the Strip Chart Display to the running minimum and maximum values in the data set.  



 
 

Strip Chart Indicators  
 
The Indicators on the Strip Chart area are: 
 
Strip Chart Plot 
Current Sample 
Data Collection Active 
Data Smoothing  
 
 

Strip Chart Plot  
 
Displays the measured data set.  
 
Power Meter Device  
 
Displays each data point as it is acquired.  
In Continuous Mode the plot functions as a strip chart and fills until Data Collection is turned off. 
In Fixed Mode the plot functions as a strip chart and fills until Batch Size is met. On Reset the 
chart clears and refills with the new batch. 
 
Energy Meter Device  
 
Displays each data batch as it is acquired.  
In Continuous Mode  the plot functions as a scope chart and plots each batch until Data 
Collection  is turned off. Previous data is held on the chart until the new batch is acquired. 
In Fixed Mode  the plot functions as a scope chart and plots each batch when Batch Size  is met. 
On Reset a new data set is taken and plotted. Previous data is held on the chart until the new 
batch is acquired. 
 
Right click on the Data Icon to set the Plot Options. 
Right click on the X-Axis set the X-Axis Options. 
Right click on the Y-Axis set the Y-Axis Options. 
 
Min and Max Tracking Cursors can be set using the Display Options Menu.  
 
 

Current Sample  
 
The current sample in the batch. Resets with the Reset Button or Auto Reset in Fixed Sample 
Collection Mode. 
 
If the Current Sample exceeds the Batch Size when Fixed Sample Collection  is selected, a 
Reset must be issued to start the new batch.  
 
 
 



Data Collection Active  
 
Illuminates when Data Collection is active.  
 
 

Data Smoothing  
 
Illuminates when Display Smoothing is active. The value of the smoothing average is shown. 
Display Smoothing is set using the Display Options Menu.  
 
 

The Histogram Display  
 
The Histogram Display is visible to the user when its tab is selected. It contains Controls and 
Indicators for the Histogram. 
 
 

 
 
 

Histogram Controls  
 
The Controls on the Histogram area are: 
 
Number of Bins  
 
 
 



Number of Bins  
 
Number of bins to be used to calculate the histogram.  
 
 

Histogram Indicators  
 
The Indicators on the Histogram area are: 
 
Current Sample 
Data Collection Active  
 
 

Current Sample  
 
The current sample in the batch. Resets with the Reset Button or Auto Reset in Fixed Sample 
Collection Mode. 
 
If the Current Sample exceeds the Batch Size when Fixed Sample Collection  is selected, a 
Reset must be issued to start the new batch.  
 
 

Data Collection Active  
 
Illuminates when Data Collection is active.  
 
 

The Tuning Needles Display  
 
The Tuning Needles Display is visible to the user when its tab is selected. It contains Controls 
and Indicators for the Tuning Needles. 
 
 



 
 
 

Tuning Needles Controls  
 
The Controls on the Tuning Needles area are: 
 
Tuning Scale 
Reset Needles  
 
 

Tuning Scale  
 
Use this button to select the scaling range of the tuning meter. 
 
Min - Max: Sets the low end of the scale range to the Minimum value in the data set and the high 
end of the scale range to the Maximum value in the data set since the last Reset Needles. 
 
Zero - Max: sets the scale range from Zero to the Maximum of the measurement Range.  
 
 

Reset Needles  
 
Resets the Minimum and Maximum to the value of Current.  
 
 

Tuning Needles Indicators  
 
The Indicators on the Tuning Needles area are: 
 



Tuning Needles 
Current 
Minimum 
Maximum 
Current Sample 
Data Collection Active  
 
 

Tuning Needles  
 
Displays the Maximum (Red Needle), Minimum (Blue Needle) and the Current (Black Needle) 
measured value. Scale Range is set with the Tuning Scale control. 
 
Minimum and Maximum are reset when Reset Needle is pressed.  
 
 

Current  
 
The Current Measured Value.  
 
 

Minimum  
 
The Minimum Measured Value.  
 
 

Maximum  
 
The Maximum Measured Value.  
 
 

Current Sample  
 
The current sample in the batch. Resets with the Reset Button or Auto Reset in Fixed Sample 
Collection Mode. 
 
If the Current Sample exceeds the Batch Size when Fixed Sample Collection  is selected, a 
Reset must be issued to start the new batch.  
 
 

Data Collection Active  
 
Illuminates when Data Collection is active.  
 
 

The Setup Display  



 
The Setup Display is visible to the user when its tab is selected. It contains Controls and 
Indicators for the Setup. 
 

 
 
 

Setup Controls  
 
The Controls on the Setup area are: 
 
Wavelength (nm) 
% Transmissivity 
Diameter (Area) 
Entry Type 
Display W/cm^2 
User Serial Number 
User Calibration Date 
Write to Instrument 
Read From Instrument  
 
 

Wavelength (nm)  
 
Enter the Wavelength of the light source being measured. 
 
Wavelengths other than the calibration wavelength may result in wavelength corrections being 
applied. If corrections are applied, the Corrections Active LED will illuminate. 
 
To view the wavelength response of the sensor, use the Display menu item.  
 
 



% Transmissivity  
 
Enter the Transmissivity of external optics being used.  
 
 

Diameter (mm) or Area (cm^2)  
 
Enter the Diameter or the Area, based on the Entry Type,  of the light source or external aperture 
being used.  
 
 

Entry Type  
 
Change the Diameter control to an Area control.  
 
 

Display W/cm^2  
 
Toggles the data displays from Watts/Joules to Irradiance/Fluence. Uses the Area indicator to 
compute the values.  
 
 

User Serial Number  
 
The User Serial Number. Stored in persistent memory  
 
 

User Calibration Date  
 
The User Calibration Date. Stored in persistent memory  
 
 

Write to Instrument  
 
Writes the User Serial Number and the User Cal Date to the persistent memory of the device.  
 
 

Read From Instrument  
 
Reads the User Serial Number and the User Cal Date from the persistent memory of the device.  
 
 

Setup Indicators  
 



The Indicators on the Setup area are: 
 
Wavelength Factor 
Transmissivity Factor 
Area (cm^2) 
SXI-D Serial Number 
SXI-D Calibration Date 
Device ID 
Firmware version  
 
 

Wavelength Factor  
 
The correction factor for the current Wavelength.  
 
 

Transmissivity Factor  
 
The correction factor for the current Transmissivity.  
 
 

Area (cm^2)  
 
The current Area of the measured beam.  
 
 

SXI-D Serial Number  
 
The Factory Serial Number.  
 
 

SXI-D Calibration date  
 
The Factory Calibration Date.  
 
 

Device ID  
 
The Device ID. The Application Software uses this to determine how to configure itself.  
 
 

Firmware Version  
 
The Device Internal Firmware Version.  
 



 

Zero Baseline  
 
Used to set the DC baseline of the Radiometer. This control helps center a signal that is drifting 
due to air currents, etc.  
 
 

Application Menus  
 
The SXI-D Application Software has three main menu items, each with its own sub menus. They 
are: 
 
The File Menu 
The Display Menu 
The Help Menu  
 
 

The "File" Menu  
 
The File  menu is used to open, close, and view data sets. The menu items are: 
 
Open Data File 
Close Data File 
View Existing Data File 
Print Window 
Exit  
 
 

Open Data File  
 
Opens a File too write data to. User is allowed to name a new file or overwrite an old one.  
 
 

Close Data File  
 
Closes the currently open data file.  
 
 

View Existing Data File  
 
Allows the user to choose an existing data file for viewing with the Data Analysis Panel.  
 
 

Print Window  
 
Prints the current window.  



 
 

Exit  
 
Exits the Application. Closes all open files and stops the SXI-D data stream. Exit saves the state 
of all Application Controls and restores them on restart.  
 
 

The "Display" Menu  
 
The Display  menu is used to modify the characteristics of the Digital Display and the Strip Chart. 
It also displays the Wavelength Correction Table stored in the sensor. The menu items are: 
 
Display Options 
View Wavelength Correction Table  
 
 

Display Options  
 
Calls new panel that allows the user to set Cursors on the Strip Chart, Cursor Colors, and Cursor 
Range.  
 
Allows the user to turn on Display Averaging and set the number of samples to average. 
Averaging is implemented as a Moving Average. 
 

 
 
If Auto Track Min/Max is selected, then the Cursors track the min and max values in the data set. 
 
If User Min/Max is Checked, then User Min and User Max set the Cursor Range. 
 
Right click on the Cursor Color Box to display a color palette. 
 
If Data Smoothing is active, the number of averages will be displayed on the Data Smoothing 
Indicator.  
 
 



View Wavelength Correction Table  
 
Calls new panel that allows the user to View the Sensor Wavelength Correction Curve.  
 
 
 

The "Help" Menu  
 
The Help menu is used to display help for the Application. The menu items are: 
 
Help 
Show Context Help 
About  
 
 

Help  
 
Calls this Help file.  
 
 

Show Context Help  
 
Shows a Context Sensitive Help Window when the Mouse Cursor is over a Control or Indicator.  
 
 

About  
 
Application Information is Displayed  
 
 

Analysis Displays  
 
Allow the User to analyze a saved data set. 
 
Data Analysis Panel 
Wavelength Corrections Panel  
 
 

Data Analysis Panel  
 
Allows the User to analyze a saved data set. 
 



 
 
 

Wavelength Corrections Panel  
 
Allows the User to view the Sensor Wavelength Corrections curve. 
 

 
 


